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Install SnapCenter Plug-in for Microsoft
Exchange Server

Installation workflow of SnapCenter Plug-in for Microsoft
Exchange Server

You should install and set up SnapCenter Plug-in for Microsoft Exchange Server if you
want to protect Exchange databases.
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Prerequisites to add hosts and install SnapCenter Plug-in
for Microsoft Exchange Server

Before you add a host and install the plug-in packages, you must complete all the
requirements.

If you are using iSCSI, the iISCSI service must be running.

You must have a domain user with local administrator privileges with local login permissions on the remote
host.

You must be using Microsoft Exchange Server 2013, 2016, or 2019 for standalone and Database
Availability Group configurations.

When installing a plug-in on a Windows host, if you specify a credential that is not built-in or if the user
belongs to a local workgroup user, you must disable UAC on the host.

If you manage cluster nodes in SnapCenter, you must have a user with administrative privileges to all the
nodes in the cluster.

You must have a user with administrative permissions on the Exchange Server.

If SnapManager for Microsoft Exchange Server and SnapDrive for Windows are already installed, you must
unregister the VSS Hardware Provider used by SnapDrive for Windows before you install Plug-in for
Exchange on the same Exchange Server to ensure successful data protection using SnapCenter.

If SnapManager for Microsoft Exchange Server and Plug-in for Exchange are installed on the same server,
you must suspend or delete from the Windows scheduler all schedules created by SnapManager for
Microsoft Exchange Server.

The host must be resolvable to the fully qualified domain name (FQDN) from the server. If the hosts file is
modified to make it resolvable and if both the short name and the FQDN are specified in the hosts file,



create an entry in the SnapCenter hosts file in the following format: <ip_address> <host_fqdn>
<host_name>.

* Ensure the following ports are not blocked in the firewall, otherwise the add host operation fails. To resolve
this issue, you must configure the dynamic port range. For more information, see Microsoft documentation.

> Port range 50000 - 51000 for Windows 2016 and Exchange 2016
> Port range 6000 - 6500 for Windows 2012 R2 and Exchange 2013
o Port range 49152 - 65536 for Windows 2019

To identify the port range, execute the following commands:

* netsh int ipv4 show dynamicport tcp
@ * netsh int ipv4 show dynamicport udp
* netsh int ipv6 show dynamicport tcp

* netsh int ipv6 show dynamicport udp

Host requirements to install SnapCenter Plug-ins Package for Windows

Before you install the SnapCenter Plug-ins Package for Windows, you should be familiar with some basic host
system space requirements and sizing requirements.

Item Requirements

Operating Systems Microsoft Windows

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Minimum RAM for the SnapCenter plug-in on host 1GB

Minimum install and log space for the SnapCenter 5GB
plug-in on host

You should allocate sufficient disk
space and monitor the storage
consumption by the logs folder. The log
space required varies depending on

@ the number of the entities to be
protected and the frequency of data
protection operations. If there is no
sufficient disk space, the logs will not
be created for the recently run
operations.


https://docs.microsoft.com/en-us/troubleshoot/windows-server/networking/configure-rpc-dynamic-port-allocation-with-firewalls
https://mysupport.netapp.com/matrix/imt.jsp?components=100747;&solution=1257&isHWU&src=IMT

Item Requirements
Required software packages » Microsoft .NET Framework 4.5.2 or later

» Windows Management Framework (WMF) 4.0 or
later

* PowerShell 4.0 or later

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Exchange Server privileges required

To enable SnapCenter to add Exchange Server or DAG, and to install SnapCenter Plug-in for Microsoft
Exchange Server on a host or DAG, you must configure SnapCenter with credentials for a user with a
minimum set of privileges and permissions.

You must have a domain user with local administrator privileges, and with local login permissions on the
remote Exchange host, as well as administrative permissions on all the nodes in the DAG. The domain user
requires the following minimum permissions:

* Add-MailboxDatabaseCopy

* Dismount-Database

* Get-AdServerSettings

* Get-DatabaseAvailabilityGroup

* Get-ExchangeServer

» Get-MailboxDatabase

* Get-MailboxDatabaseCopyStatus

* Get-MailboxServer

* Get-MailboxStatistics

» Get-PublicFolderDatabase

* Move-ActiveMailboxDatabase

» Move-DatabasePath -ConfigurationOnly:$true

* Mount-Database

* New-MailboxDatabase

* New-PublicFolderDatabase

* Remove-MailboxDatabase

* Remove-MailboxDatabaseCopy

* Remove-PublicFolderDatabase

* Resume-MailboxDatabaseCopy

» Set-AdServerSettings

+ Set-MailboxDatabase -allowfilerestore:$true

» Set-MailboxDatabaseCopy


https://mysupport.netapp.com/matrix/imt.jsp?components=100747;&solution=1257&isHWU&src=IMT

« Set-PublicFolderDatabase
» Suspend-MailboxDatabaseCopy
» Update-MailboxDatabaseCopy

Configure gMSA on Windows Server 2012 or later

Before you install the SnapCenter Plug-ins Package for Windows, you should be familiar with some basic host
system space requirements and sizing requirements.

Item Requirements

Operating Systems Microsoft Windows

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Minimum RAM for the SnapCenter plug-in on host 1GB

Minimum install and log space for the SnapCenter 5GB

plug-in on host
You should allocate sufficient disk
space and monitor the storage
consumption by the logs folder. The log
space required varies depending on

@ the number of the entities to be

protected and the frequency of data
protection operations. If there is no
sufficient disk space, the logs will not
be created for the recently run
operations.

Required software packages * Microsoft NET Framework 4.5.2 or later

* Windows Management Framework (WMF) 4.0 or
later

* PowerShell 4.0 or later

For the latest information about supported versions,
see the NetApp Interoperability Matrix Tool.

Set up credentials for SnapCenter Plug-in for Windows

SnapCenter uses credentials to authenticate users for SnapCenter operations. You
should create credentials for installing the plug-in package and additional credentials for
performing data protection operations on databases.

About this task

You must set up credentials for installing plug-ins on Windows hosts. Although you can create credentials for
Windows after deploying hosts and installing plug-ins, the best practice is to create credentials after you add


https://mysupport.netapp.com/matrix/imt.jsp?components=100747;&solution=1257&isHWU&src=IMT
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SVMs, before you deploy hosts and install plug-ins.
Set up the credentials with administrator privileges, including administrator rights on the remote host.

If you set up credentials for individual resource groups and the username does not have full admin privileges,
you must assign at least the resource group and backup privileges to the username.

Steps

1. In the left navigation pane, click Settings.
2. In the Settings page, click Credential.
3. Click New.

The Credential window is displayed.

4. In the Credential page, do the following:

For this field... Do this...
Credential name Enter a name for the credential.
Username Enter the user name used for authentication.

* Domain administrator or any member of the
administrator group

Specify the domain administrator or any
member of the administrator group on the
system on which you are installing the
SnapCenter plug-in. Valid formats for the
Username field are:

° NetBIOS\UserName
° Domain FQDN\UserName

 Local administrator (for workgroups only)

For systems that belong to a workgroup, specify
the built-in local administrator on the system on
which you are installing the SnapCenter plug-in.
You can specify a local user account that
belongs to the local administrators group if the
user account has elevated privileges or the User
Access control feature is disabled on the host
system. The valid format for the Username field
is: UserName

Password Enter the password used for authentication.

Authentication Select Windows as the authentication mode.



5. Click OK.

Configure gMSA on Windows Server 2012 or later

Windows Server 2012 or later enables you to create a group Managed Service Account (gMSA) that provides
automated service account password management from a managed domain account.

What you will need

* You should have a Windows Server 2012 or later domain controller.

* You should have a Windows Server 2012 or later host, which is a member of the domain.

Steps

1. Create a KDS root key to generate unique passwords for each object in your gMSA.

2. For each domain, run the following command from the Windows domain controller: Add-KDSRootKey
-Effectivelmmediately

3. Create and configure your gMSA:

a. Create a user group account in the following format:
domainName\accountNames$

b. Add computer objects to the group.

c. Use the user group you just created to create the gMSA.

For example,

New-ADServiceAccount -name <ServiceAccountName> -DNSHostName <fgdn>
-PrincipalsAllowedToRetrieveManagedPassword <group>
-ServicePrincipalNames <SPN1, SPN2,..>

d. Run Get-ADServiceAccount command to verify the service account.

4. Configure the gMSA on your hosts:

a. Enable the Active Directory module for Windows PowerShell on the host where you want to use the
gMSA account.

To do this, run the following command from PowerShell:



PS C:\> Get-WindowsFeature AD-Domain-Services

Display Name Name Install
State

[ ] Active Directory Domain Services AD-Domain-Services Available

PS C:\> Install-WindowsFeature AD-DOMAIN-SERVICES

Success Restart Needed Exit Code Feature Result

True No Success {Active Directory Domain
Services, Active

WARNING: Windows automatic updating is not enabled. To ensure that
your newly-installed role or feature 1is

automatically updated, turn on Windows Update.

b. Restart your host.

c. Install the gMSA on your host by running the following command from the PowerShell command
prompt: Install-AdServiceAccount <gMSA>

d. Verify your gMSA account by running the following command: Test-AdServiceAccount <gMSA>
5. Assign the administrative privileges to the configured gMSA on the host.
6. Add the Windows host by specifying the configured gMSA account in the SnapCenter Server.

SnapCenter Server will install the selected plug-ins on the host and the specified gMSA will be used as the
service log on account during the plug-in installation.

Add hosts and install Plug-in for Exchange

You can use the SnapCenter Add Host page to add Windows hosts. The Plug-in for
Exchange is automatically installed on the specified host. This is the recommended
method for installing plug-ins. You can add a host and install a plug-in either for an
individual host or a cluster.

What you will need

* You must be a user that is assigned to a role that has the plug-in install and uninstall permissions, such as
the SnapCenter Admin.

» When installing a plug-in on a Windows host, if you specify a credential that is not built-in, or if the user
belongs to a local workgroup user, you must disable UAC on the host.

* The message queueing service must be running.

* If you are using group Managed Service Account (gMSA), you should configure gMSA with administrative



privileges. For information, see Configure group Managed Service Account on Windows Server 2012 or
later.

About this task
You cannot add a SnapCenter Server as a plug-in host to another SnapCenter Server.

You can add a host and install plug-in packages either for an individual host or a cluster. If you are installing
plug-ins on a cluster (Exchange DAG), they are installed on all of the nodes of the cluster even if some of
nodes do not have databases on NetApp LUNSs.

Plug-in for Exchange depends on SnapCenter Plug-ins Package for Windows, and the versions must be the
same. During the Plug-in for Exchange installation, SnapCenter Plug-ins Package for Windows is selected by
default and is installed along with the VSS Hardware Provider.

If SnapManager for Microsoft Exchange Server and SnapDrive for Windows are already installed, and you
want to install Plug-in for Exchange on the same Exchange Server, you must unregister the VSS Hardware
Provider used by SnapDrive for Windows because it is incompatible with the VSS Hardware Provider installed
with Plug-in for Exchange and SnapCenter Plug-ins Package for Windows.

Steps

1. In the left navigation pane, click Hosts.

2. Verify that Managed Hosts is selected at the top.
3. Click Add.

4. On the Hosts page, do the following:

For this field... Do this...
Host Type Select Windows as the host type.

SnapCenter Server adds the host and then installs
on the host the Plug-in for Windows and the Plug-in
for Exchange if they are not already installed.

Plug-in for Windows and Plug-in for Exchange must
be the same version. If a different version of Plug-in
for Windows was previously installed, SnapCenter
updates the version as part of the installation.



For this field... Do this...

Host name Enter the fully qualified domain name (FQDN) or the
IP address of the host.

SnapCenter depends on the proper configuration of
the DNS. Therefore, the best practice is to enter the
fully qualified domain name (FQDN).

An IP address is supported for untrusted domain
hosts only if it resolves to the FQDN.

You can enter IP addresses or the FQDN of one of
the following:

» Stand-alone host
» Exchange DAG

If you are adding a host using SnapCenter and it is
part of a subdomain, you must provide the FQDN.

You can also add the IP less DAG cluster by
providing the IP address or the FQDN of one of the
DAG cluster nodes.

Credentials Select the credential name that you created, or
create the new credentials.

The credential must have administrative rights on
the remote host. For details, see information about
creating a credential.

You can view details about the credentials by
positioning your cursor over the credential name
that you specified.

Credentials authentication mode is
determined by the host type that you
specify in the Add Host wizard.

5. In the Select Plug-ins to Install section, select the plug-ins to install.

When you select Plug-in for Exchange, SnapCenter Plug-in for Microsoft SQL Server is deselected
automatically. Microsoft recommends that SQL Server and Exchange server not be installed on the same
system due to the amount of memory used and other resource usage required by Exchange.

6. (Optional) Click More Options.



7.

8.
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For this field...
Port

Installation Path

Add all hosts in the DAG

Skip preinstall checks

Use group Managed Service Account (gMSA) to run
the plug-in services

Click Submit.

Do this...

Either retain the default port number or specify the
port number.

The default port number is 8145. If the SnapCenter
Server was installed on a custom port, that port
number will be displayed as the default port.

If you manually installed the plug-ins
and specified a custom port, you
must specify the same port.
Otherwise, the operation fails.

®

The default path is C: \Program
Files\NetApp\SnapCenter.

You can optionally customize the path.
Select this check box when you add a DAG.

Select this check box if you already installed the
plug-ins manually and you do not want to validate
whether the host meets the requirements for
installing the plug-in.

Select this check box if you want to use group
Managed Service Account (QMSA) to run the plug-in
services.

Provide the gMSA name in the following format:
domainName\accountName$.

®

gMSA will be used as a log on
service account only for SnapCenter
Plug-in for Windows service.

If you have not selected the Skip prechecks check box, the host is validated to determine whether it meets
the requirements to install the plug-in. If the minimum requirements are not met, the appropriate error or

warning messages are displayed.

If the error is related to disk space or RAM, you can update the web.config file located at C: \Program
Files\NetApp\SnapCenter WebApp to modify the default values. If the error is related to other

parameters, you must fix the issue.

®

Monitor the installation progress.

In an HA setup, if you are updating web.config file, you must update the file on both nodes.



Install Plug-in for Exchange from the SnapCenter Server
host using PowerShell cmdlets

You should install the Plug-in for Exchange from the SnapCenter GUI. If you do not want
to use the GUI, you can use PowerShell cmdlets on the SnapCenter Server host or on a
remote host.

What you will need

» SnapCenter Server must have been installed and configured.
* You must be a local administrator on the host or a user with administrative privileges.

* You must be a user that is assigned to a role that has the plug-in, install, and uninstall permissions, such as
the SnapCenter Admin.

* You must have reviewed the installation requirements and types of supported configurations before
installing the Plug-in for Exchange.

» The host on which you want the Plug-in for Exchange installed must be a Windows host.
Steps

1. On the SnapCenter Server host, establish a session using the Open-SmConnection cmdlet, and then enter
your credentials.

2. Add the host on which you want to install the Plug-in for Exchange using the Add-SmHost cmdlet with the
required parameters.

The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter
Software Cmdlet Reference Guide.

The host can be a standalone host or a DAG. If you specify a DAG, the -IsDAG parameter is required.
3. Install the Plug-in for Exchange using the Install-SmHostPackage cmdlet with the required parameters.

This command installs the Plug-in for Exchange on the specified host, and then registers the plug-in with
SnapCenter.

Install the SnapCenter Plug-in for Exchange silently from
the command line

You should install Plug-in for Exchange from within the SnapCenter user interface.
However, if you cannot for some reason, you can run the Plug-in for Exchange installation
program unattended in silent mode from the Windows command line.

What you will need

* You must have backed up your Microsoft Exchange Server resources.
* You must have installed the SnapCenter plug-in packages.

* You must delete the earlier release of SnapCenter Plug-in for Microsoft SQL Server before installing.

11
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For more information, see How to Install a SnapCenter Plug-In manually and directly from the Plug-In Host.

Steps

1. Validate whether C:\temp folder exists on the plug-in host and the logged in user has full access to it.

2. Download the SnapCenter Plug-in for Microsoft Windows from

C:\ProgramData\NetApp\SnapCenter\Package Repository.

This path is accessible from the host where the SnapCenter Server is installed.

3. Copy the installation file to the host on which you want to install the plug-in.

4. From a Windows command prompt on the local host, navigate to the directory to which you saved the plug-

in installation files.

5. Enter the following command to install replacing the variables with your data:

12

snapcenter_windows_host_plugin.exe'/silent /debuglog"<Debug Log Path>"/log"<Log Path>"
BI_SNAPCENTER_PORT=<Num> SUITE_INSTALLDIR="<Install_Directory Path>"
BI_SERVICEACCOUNT=<domain\administrator> Bl _SERVICEPWD=<password>
ISFeaturelnstallFHPPW,SCW,SCE

For example:

C:\ProgramData\NetApp\SnapCenter\Package Repository\snapcenter_windows_host_plugin.exe'/silent
/debuglog"C:\HPPW _SCSQL_Install.log" /log"C:\temp" Bl_SNAPCENTER_PORT=8145
SUITE_INSTALLDIR="C:\Program Files\NetApp\SnapCenter"

Bl SERVICEACCOUNT=domain\administrator Bl_SERVICEPWD=password
ISFeaturelnstall=HPPW,SCW,SCE

@ All the parameters passed during the installation of Plug-in for Exchange are case sensitive.

a. /silent /debuglog"C:\Installdebug.log” /log"C:\temp" BIl_SNAPCENTER_PORT=8145
SUITE_INSTALLDIR="C:\Program Files" BI_SERVICEACCOUNT=demo\administrator
BlI_SERVICEPWD=Netapp1! ISFeaturelnstall=HPPW,SCW
Enter the following values for the variables:

Variable Value

/debuglog"<Debug Log Path> Specify the name and location of the suite
installer log file, as in the following example:

Setup.exe /debuglog”C:\PathToLog\setupexe.log

Bl_SNAPCENTER_PORT Specify the port on which SnapCenter
communicates with SMCore.

SUITE_INSTALLDIR Specify host plug-in package installation directory.

BI_SERVICEACCOUNT Specify SnapCenter Plug-in for Microsoft
Windows web service account.


https://kb.netapp.com/Advice_and_Troubleshooting/Data_Protection_and_Security/SnapCenter/How_to_Install_a_SnapCenter_Plug-In_manually_and_directly_from_thePlug-In_Host

Variable Value

BI_SERVICEPWD Specify the password for SnapCenter Plug-in for
Microsoft Windows web service account.

ISFeaturelnstall Specify the solution to be deployed by
SnapCenter on remote host.

6. Monitor the Windows task scheduler, the main installation log file C:\Installdebug.log, and the additional
installation files in C:\Temp.

7. Monitor the %temp% directory to check if the msiexe.exe installers are installing the software without
errors.

The installation of Plug-in for Exchange registers the plug-in on the host and not on the

@ SnapCenter Server. You can register the plug-in on the SnapCenter Server by adding the
host using the SnapCenter GUI or PowerShell cmdlet. After the host is added, the plug-in is
automatically discovered.

Monitor SnapCenter plug-in package installation status

You can monitor the progress of SnapCenter plug-in package installation by using the Jobs page. You might
want to check the progress of installation to determine when it is complete or if there is an issue.

About this task

The following icons appear on the Jobs page and indicate the state of the operation:

In progress
. Completed successfully
« x Failed

Completed with warnings or could not start due to warnings
* D Queued

Steps

1. In the left navigation pane, click Monitor.
2. In the Monitor page, click Jobs.
3. On the Jobs page, to filter the list so that only plug-in installation operations are listed, do the following:
a. Click Filter.
b. Optional: Specify the start and end date.
c. From the Type drop-down menu, select Plug-in installation.
d. From the Status drop-down menu, select the installation status.
. Click Apply.

4. Select the installation job and click Details to view the job details.

0]
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5. In the Job Details page, click View logs.

Configure CA Certificate

Generate CA Certificate CSR file

You can generate a Certificate Signing Request (CSR) and import the certificate that can be obtained from a
Certificate Authority (CA) using the generated CSR. The certificate will have a private key associated with it.

CSR is a block of encoded text that is given to an authorized certificate vendor to procure the signed CA
certificate.

For information to generate a CSR, see How to generate CA Certificate CSR file.

If you own the CA certificate for your domain (*.domain.company.com) or your system
(machine1.domain.company.com), you can skip generating the CA Certificate CSR file. You can
deploy the existing CA certificate with SnapCenter.

For cluster configurations, the cluster name (virtual cluster FQDN), and the respective host names should be
mentioned in the CA certificate. The certificate can be updated by filling the Subject Alternative Name (SAN)
field before procuring the certificate. For a wild card certificate (*.domain.company.com), the certificate will
contain all the hostnames of the domain implicitly.

Import CA certificates

You must import the CA certificates to the SnapCenter Server and the Windows host plug-ins using the
Microsoft management console (MMC).

Steps

1. Go to the Microsoft management console (MMC), and then click File > Add/Remove Snapin.
In the Add or Remove Snap-ins window, select Certificates and then click Add.

In the Certificates snap-in window, select the Computer account option, and then click Finish.

> o N

Click Console Root > Certificates — Local Computer > Trusted Root Certification Authorities >
Certificates.

5. Right-click on the folder “Trusted Root Certification Authorities”, and then select All Tasks > Import to start
the import wizard.

6. Complete the wizard, as follows:

In this wizard window... Do the following...

Import Private Key Select the option Yes, import the private key, and
then click Next.

Import File Format Make no changes; click Next.

Security Specify the new password to be used for the
exported certificate, and then click Next.

14
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In this wizard window... Do the following...

Completing the Certificate Import Wizard Review the summary, and then click Finish to start
the import.

@ Importing certificate should be bundled with the private key (supported formats are: *.pfx,
*.p12, *.p7b).

7. Repeat Step 5 for the “Personal” folder.

Get the CA certificate thumbprint

A certificate thumbprint is a hexadecimal string that identifies a certificate. A thumbprint is calculated from the
content of the certificate using a thumbprint algorithm.

Steps

1. Perform the following on the GUI:
a. Double-click the certificate.
b. In the Certificate dialog box, click the Details tab.
c. Scroll through the list of fields and click Thumbprint.
d. Copy the hexadecimal characters from the box.

e. Remove the spaces between the hexadecimal numbers.

For example, if the thumbprint is: "a9 09 50 2d d8 2a e4 14 33 e6 f8 38 86 b0 0d 42 77 a3 2a 7b", after
removing the spaces, it will be: "a909502dd82ae41433e6f83886b00d4277a32a7b".

2. Perform the following from PowerShell:

a. Run the following command to list the thumbprint of the installed certificate and identify the recently
installed certificate by the subject name.

Get-Childltem -Path Cert:\LocalMachine\My

b. Copy the thumbprint.

Configure CA certificate with Windows host plug-in services

You should configure the CA certificate with Windows host plug-in services to activate the installed digital
certificate.

Perform the following steps on the SnapCenter Server and all the plug-in hosts where CA certificates are
already deployed.

Steps
1. Remove the existing certificate binding with SMCore default port 8145, by running the following command:
> netsh http delete sslcert ipport=0.0.0.0: <SMCore Port>

For example:

15



> netsh http delete sslcert ipport=0.0.0.0:8145

2. Bind the newly installed certificate with the Windows host plug-in services, by running the following

commands:
> Scert = “<certificate thumbprint>"
> $Sguid = [guid]::NewGuid () .ToString ("B")

> netsh http add sslcert ipport=0.0.0.0: <SMCore Port> certhash=S$cert
appid="S$guid"

For example:

> Scert = “a909502dd82ae41433e6f838860b00d4277a32a7b”

> Sguid = [guid]::NewGuid () .ToString ("B")

> netsh http add sslcert ipport=0.0.0.0:8145 certhash=$cert
appid="$guid"

Enable CA Certificates for plug-ins

You should configure the CA certificates and deploy the CA certificates in the SnapCenter Server and the
corresponding plug-in hosts. You should enable the CA certificate validation for the plug-ins.

What you will need

* You can enable or disable the CA certificates using the run Set-SmCertificateSettings cmdlet.

* You can display the certificate status for the plug-ins using the Get-SmCetrtificateSettings.
The information regarding the parameters that can be used with the cmdlet and their descriptions can be
obtained by running Get-Help command_name. Alternatively, you can also refer to the SnapCenter Software
Cmdlet Reference Guide.

Steps

—_

. In the left navigation pane, click Hosts.
2. In the Hosts page, click Managed Hosts.
3. Select single or multiple plug-in hosts.

4. Click More options.

5. Select Enable Certificate Validation.

After you finish

The Managed Hosts tab host displays a padlock and the color of the padlock indicates the status of the
connection between SnapCenter Server and the plug-in host.

. indicates that the CA certificate is neither enabled nor assigned to the plug-in host.
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. indicates that the CA certificate is successfully validated.
* | indicates that the CA certificate could not be validated.

* @ indicates that the connection information could not be retrieved.

@ When the status is yellow or green, the data protection operations completes successfully.

Configure SnapManager 7.x for Exchange and SnapCenter
to coexist

To enable SnapCenter Plug-in for Microsoft Exchange Server to coexist with
SnapManager for Microsoft Exchange Server, you need to install SnapCenter Plug-in for
Microsoft Exchange Server on the same Exchange Server on which SnapManager for
Microsoft Exchange Server is installed, disable SnapManager for Exchange schedules,
and configure new schedules and backups using SnapCenter Plug-in for Microsoft
Exchange Server.

What you will need
« SnapManager for Microsoft Exchange Server and SnapDrive for Windows are already installed, and

SnapManager for Microsoft Exchange Server backups exist on the system and in the Snaplinfo directory.

* You should have deleted or reclaimed backups taken by SnapManager for Microsoft Exchange Server that
you no longer require.

* You should have suspended or deleted all schedules created by SnapManager for Microsoft Exchange
Server from the Windows scheduler.

« SnapCenter Plug-in for Microsoft Exchange Server and SnapManager for Microsoft Exchange Server can
coexist on the same Exchange Server, but you cannot upgrade existing SnapManager for Microsoft
Exchange Server installations to SnapCenter.

SnapCenter does not provide an option for the upgrade.

« SnapCenter does not support restoring Exchange databases from SnapManager for Microsoft Exchange
Server backup.

If you do not uninstall SnapManager for Microsoft Exchange Server after the SnapCenter Plug-in for
Microsoft Exchange Server installation and later want to restore a SnapManager for Microsoft Exchange
Server backup, you must perform additional steps.

Steps

1. Using PowerShell on all DAG nodes, determine whether the SnapDrive for Windows VSS Hardware
Provider is registered: vssadmin list providers
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C:\Program Files\NetApp\SnapDrive>vssadmin list providers
vssadmin 1.1 - Volume Shadow Copy Service administrative command-line
tool

(C) Copyright 2001-2013 Microsoft Corp.

Provider name: 'Data ONTAP VSS Hardware Provider'
Provider type: Hardware
Provider Id: {ddd3d232-a96f-4ac5-8f7b-250£fd91fd102}
Version: 7. 1. 4. 6845

. From the SnapDrive directory, unregister the VSS Hardware Provider from SnapDrive for Windows:

navssprv.exe -r service —u

3. Verify that the VSS Hardware Provider was removed: vssadmin list providers
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. Add the Exchange host to SnapCenter, and then install the SnapCenter Plug-in for Microsoft Windows and

the SnapCenter Plug-in for Microsoft Exchange Server.

. From the SnapCenter Plug-in for Microsoft Windows directory on all DAG nodes, verify that the VSS

Hardware Provider is registered: vssadmin list providers

[PS] C:\Windows\system32>vssadmin list providers

vssadmin 1.1 - Volume Shadow Copy Service administrative command-line
tool

(C) Copyright 2001-2013 Microsoft Corp.

Provider name: 'Data ONTAP VSS Hardware Provider'
Provider type: Hardware
Provider Id: {31fcab584-72be-45b6-9419-53a3277301d1}
Version: 7. 0. 0. 5561

Stop the SnapManager for Microsoft Exchange Server backup schedules.

Using the SnapCenter GUI, create on-demand backups, configure scheduled backups, and configure
retention settings.

. Uninstall SnapManager for Microsoft Exchange Server.

If you do not uninstall SnapManager for Microsoft Exchange Server now and later want to restore a
SnapManager for Microsoft Exchange Server backup:

a. Unregister SnapCenter Plug-in for Microsoft Exchange Server from all DAG nodes: navssprv.exe -r

service -u

C:\Program Files\NetApp\SnapCenter\SnapCenter Plug-in for Microsoft
Windows>navssprv.exe —-r service -u

b. From the C:\Program Files\NetApp\SnapDrive\ directory, register SnapDrive for Windows on all DAG
nodes: navssprv.exe -r service -a hostname\\username -p password
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